
7th Standard

TNPSC TET SI EXAM
8. 7ஆம்  வகுப்பு Q அறிவியல்  தேர்வு

கீழ்காண் பவற்றுள்  அடிப்படை அலகு எது?

(a) பரப்பு  (b) பருமன்  (c) ஒளிச்செறிவு  (d) வேகம்

பொருளின்  அளவு என்ற அடிப்படை அளவின்  அலகு என்ன?

(a) கேண் டிலா  (b) மோல்  (c) கெல்வின்  (d) ஆம்பியர்

அடிப்படை அளவுகள்  மொத்தம்  எத்தனை?

(a) 7  (b) 6  (c) 5  (d) 8

முக்கோணத்தின்  பரப்பு சூத்திரம்

(a) a  (b) πr  (c) l x b  (d) 1/2 b x h2 2

பருமன்  = அடிப்பரப்பு x_______ 

(a) உயரம்  (b) நீளம்  (c) அகலம்  (d) ஆரம்

திரவத்தின்  கன அளவை எதன்  மூலம்  அளவிடலாம்?

(a) உருளை  (b) அளவு நாடா  (c) சூத்திரம்  (d) அளவிடும்  குவளை

ஒரு பொருளில்  அடங்கியுள்ள மொத்த மூலக்கூறுகளின்  அளவு

(a) எடை  (b) நிறை  (c) நீளம்  (d) பருமன்

1 கேலன்  =____ 

(a) 30 மி.லி  (b) 3785 மி.லி  (c) 1000 மி.லி  (d) 300 மி.லி

பொருள்  ஆக்கிரமித்துக் கொள்ளும்  இடமே அதன்

(a) நிறை  (b) பரப்பு  (c) பருமன்  (d) அடர்த்தி

பொருள்  இலேசானதா அல்லது கனமானதா என்பதை தீர்மானிப்பது

(a) பருமன்  (b) நீளம்  (c) பரப்பு  (d) அடர்த்தி

ஒரு நாட்டிக்கல்  மைல்  என்பது

(a) 2 கி.மீ  (b) 1.5 கி.மீ  (c) 1.852 கி.மீ  (d) 3 கி.மீ

1 கி.மீ/மணி =____ 

(a) 18/5 மீ/வி  (b) 5/18 மீ/வி  (c) 9/5 மீ/வி  (d) 5/9 மீ/வி

30 விநாடியில்  50 கி.மீ தூரம்  சென்ற காரின்  வேகம்  என்ன?

(a) 50 கி.மீ/மணி  (b) 75 கி.மீ/மணி  (c) 200 கி.மீ/மணி  (d) 100 கி.மீ/மணி

ஒரு பொருள்  சீரான கால இடைவெளிகளில்  வெவ்வேறு தொலைவினைக் கடந்தால்
அப்பொருள்

(a) சீரான வேகத்தில்  செல்கிறது  (b) சீரற்ற வேகத்தில்  செல்கிறது
(c) நேர் முடுக்கம்  அடைகிறது  (d) எதிர் முடுக்கம்  அடைகிறது

ஒரு பொருளின்  திசைவேகமானது காலத்தினைப் பொறுத்து குறைந்து கொண் டே வந்தால்
அது

(a) எதிர் முடுக்கம்  (b) நேர் முடுக்கம்  (c) திசைவேகம்  (d) வேகம்

வெற்றிடத்தில்  ஒளியின்  திசைவேகம்

(a) 3 × 10  மீ/வி  (b) 30 × 10  மீ/வி  (c) 3 x 10  மீ/வி  (d) 5 x 10  மீ/வி7 8 8 8
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பொருளின்  எடை முழுவதும்  செயல்படும்  புள்ளி அப்பொருளின்

(a) நிறை  (b) விசை  (c) ஈர்ப்பு மையம்  (d) பருமன்

ஒழுங்கான வடிவமுடைய பொருள்களுக்கு அதன்  _______ஈர்ப்பு மையம்  ஆகும் .

(a) வலது முனை  (b) இடது முனை  (c) வடிவியல்  மையம்  (d) இவற்றில்  ஏதுமில்லை

பேரண் டத்தில்  முதன்மையாகக் காணப்படுவது

(a) ஆக்ஸிஜன்  (b) கார்பன்  (c) ஹைட்ரஜன்  (d) நைட்ரஜன்

இயற்கைத் தனிமங்களின்  எண் ணிக்கை

(a) 94  (b) 118  (c) 24  (d) 56

பின்வருவனவற்றுள்  எது மென்மையான உலோகம்?

(a) தங்கம்  (b) சல்ஃபர்  (c) கால்சியம்  (d) சோடியம்

உலோகப் பளபளப்பு கொண் ட அலோகம்

(a) பாதரசம்  (b) வைரம்  (c) சிலிக்கான்  (d) ஆர்கான்

அறை வெப்பநிலையில் , நீ ர்ம நிலையில்  காணப்படும்  ஒரே அலோகம்

(a) புரோமின்  (b) பாதரசம்  (c) போரான்  (d) சல்பர்

பின்வருவனவற்றுள்  எது உலோகப்போலி அல்ல?

(a) ஜெர்மனியம்  (b) ஆர்சனிக்  (c) துத்தநாகம்  (d) போரான்

தனிமங்களின்  குறியீடுகளைத் தகுந்த முறையில்  பயன்படுத்திய முதல்  வேதியியல்  அறிஞர்

(a) மோஸ் லே  (b) டால்டன்  (c) பாயில்  (d) ப்ரௌன்

அணுக்கட்டு எண்  நான்கு கொண் ட மூலக்கூறு

(a) சிலிக்கான்  (b) நைட்ரஜன்  (c) கார்பன்  (d) பாஸ் பரஸ்

பருப்பொருளைச் சூடேற்றுதல்  தொடர்பான தவறான கூற்று எது?

(a) திண் மத்துகள்கள்  அதிர்வுறுகின்றன.
(b) துகள்களின்  பரிமாணத்தில்  எவ்வித மாற்றமுமில்லை.

(c) பருப்பொருளின்  நிறையில்  மாற்றம்  ஏற்படுகிறது.
(d) துகள்களின்  எண் ணிக்கையில்  மாற்றம்  ஏதுமில்லை.

இரயில்  தண் டவாளங்களின்  இணைப்பிலுள்ள இடைவெளி பின்வரும்  எந்த
செயல்முறையினால்  நிரப்பப்படுகிறது?

(a) வெப்பத்தினால்  விரிவடைதல்  (b) குளிர்ச்சியினால்  சுருங்குதல்
(c) அழுத்தம்  அதிகரிப்பு  (d) உலோகக் கலவை உருவாக்குதல்

ரூதர்போர்டு தனது தங்கத்தகடு ஆய்விற்குப் பயன்படுத்திய கதிர்கள்

(a) பீட்டா  (b) காமா  (c) X-கதிர்கள்  (d) ஆல்பா

நியூட்ரான்களைக் கொண் டிராத தனிம அணுக்கரு

(a) ஹைட்ரஜன்  (b) ஹீலியம்  (c) யுரேனியம்  (d) கார்பன்

ஏறக்குறைய சமமான நிறை கொண் ட துகள்கள்

(a) புரோட்டான்  மற்றும்  எலக்ட்ரான்  (b) புரோட்டான்  மற்றும்  நியூட்ரான்
(c) எலக்ட்ரான்  மற்றும்  நியூட்ரான்  (d) புரோட்டான் , எலக்ட்ரான்  & நியூட்ரான்

Na  ஐசோடோப்பிலுள்ள நியூட்ரான்களின்  எண் ணிக்கை

(a) 11  (b) 12  (c) 23  (d) 34

11
23

சம எண் ணிக்கையிலான அடிப்படைத் துகள்களைக் கொண் ட ஐசோடோப்பு

(a) Be  (b) B  (c) C  (d) O4
9

5
11

6
12 8

17

நியூட்ரான்களின்  எண் ணிக்கை = ?
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(a) A - P  (b) A + P  (c) A + Z  (d) A + e

ஐசோபார்கள்  பின்வரும்  எதனைச் சமஅளவு கொண் டுள்ளன?

(a) அணு எண்  (b) நியூட்ரான்கள்  (c) எலக்ட்ரான்கள்  (d) நிறை எண்

அம்மோனியா மூலக்கூறிலுள்ள நைட்ரஜனின்  இணைதிறன்

(a) 1  (b) 2  (c) 3  (d) 0

பின்வரும்  இரும்பு ஆக்ஸைடுகளுள் , இரும்பின்  இணைதிறன்  3 கொண் டுள்ள சேர்மம்

(a) Fe O  (b) FeO  (c) Fe O  (d) அனைத்தும்2 3 3 4

பின்வருவனவற்றுள்  இணைதிறன்  1 கொண் டுள்ள இணை எது?

(a) O மற்றும்  Br  (b) Na மற்றும்  H  (c) Al மற்றும்  N  (d) Fe மற்றும்  Be

மலரின்  எப்பகுதி பூச்சிகளையும் , பறவைகளையும்  ஈர்க்கிறது?

(a) புல்லி  (b) அல்லி  (c) சூல்  தண் டு  (d) மகரந்தத்தாள்  கம்பி

______ என்பது மலரின்  பெண்  இனப்பெருக்க உறுப்பு ஆகும் .

(a) மகரந்தத்தாள்  வட்டம்  (b) சூலக வட்டம்  (c) புல்லி  (d) அல்லி

கீழ்க்கண் டவற்றில்  எது மஞ்சரி?

(a) ட்ரைடாக்ஸ்  (b) ரோஜா  (c) பூசணி  (d) வெள்ளரி

கீழ்க்கண் டவற்றில்  எது ஸ் போர்களை உருவாக்கும்?

(a) ஆல்கா  (b) பூஞ்சை  (c) மாஸ் கள்  (d) அனைத்தும்

______ இலை மாற்றுருவிற்கு எடுத்துக்காட்டாகும் .

(a) கள்ளி  (b) அகேஷியா  (c) அவிசினியா  (d) சேப்பக்கிழங்கு

_____ கதிர் வடிவ வேராகும் .

(a) பீட்ரூட்  (b) கேரட்  (c) முள்ளங்கி  (d) டர்னிப்

வெற்றிலை மற்றும்  மிளகுக் கொடிகளின்  கணு மற்றும்  கணுவிடைப் பகுதியிலிருந்து
தோன்றும்  வேர்கள்  _______ உதவுகின்றது.

(a) கூடுதல்  உதவிக்கு  (b) தாங்கி நிற்க  (c) உணவை உறிஞ்ச  (d) பற்றி ஏற

தரைகீழ்த் தண் டின்  மாற்றுரு______ வகையாக பிரிக்கப்பட்டுள்ளது.

(a) இரண் டு  (b) மூன்று  (c) நான்கு  (d) ஐந்து

நெப்பந்தஸ் ______ குறைவான மண் ணில்  வளர்கிறது.

(a) நைட்ரஜன்  (b) ஆக்ஸிஜன்  (c) பாஸ் பரஸ்  (d) கார்பன்

உருளைக்கிழங்கு_____ க்கு எடுத்துக்காட்டாகும் .

(a) கிழங்கு  (b) குமிழம்  (c) கந்தம்  (d) மட்டநிலத்தண் டு

ஒரு குழந்தைக்கு வயிற்றுப்போக்கு ஏன்  ஏற்படுகிறது?

(a) பெற்றோர் செய்த தவறு  (b) கடவுளின்  கோபம்  (c) தொற்று ஏற்பட்டுள்ளது
(d) மேற்கூறிய எதுவுமில்லை

கீழ்க்கண் டவற்றுள்  தொற்று நோய்  எது?

(a) டெங்கு  (b) ஆஸ் துமா  (c) சீரோப்தால்மியா  (d) லூக்கோடெர்மா

வெளிர் அல்லது எளிதில்  புலப்படுகின்ற தோல் , வெளிர்த்த கண் ணிமையின்  உள்  பரப்பு,
வெளிர்த்த விரல்  நகம் , வெளிர்ந்த ஈறுகள் , பலவீனம்  மற்றும்  சோர்வு _____ ன்  அறிகுறி.

(a) மாலைக்கண்  (b) ஹெப்பாடிட்டிஸ்  (c) பெல்லாக்ரா  (d) இரத்த சோகை

டைபாய்டு காய்ச்சலின்  அதிகபட்ச அளவு

(a) 100° F  (b) 104° F  (c) 108°F  (d) 98⁰ F

வண் ணக்குருட்டுத் தன்மை ______ ஆல்  ஏற்படுகிறது.

35)

36)

37)

38)

39)

40)

41)
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49)
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(a) பாக்டீரியா  (b) வைரஸ்  (c) வைட்டமின்  பற்றாக்குறை  (d) மரபு வழி

டெங்கு கொசுவால்______  பரவுகிறது.

(a) ஏடிஸ்  எஜிப்டி  (b) ஏடிடிஸ்  எஜிப்டி  (c) எஜிப்டியானோ ஏடிஸ்  (d) ஏஜிப்டி ஏடிஸ்

நோய்  எதிர்ப்பு சக்தி கொண் ட கண்  சொட்டு மருந்து______  நோய்க்கு தீர்வாகும் .

(a) இரவு குருட்டுத்தன்மை  (b) இளம்  சிவப்புக்கண்  நோய்  (c) வண் ணக் குருட்டுத்தன்மை
(d) மேற்கூறிய அனைத்தும்

கீழ்க்கண் டவற்றில்  எது தீங்கு விளைவிக்கக்கூடிய வெளிப்புற காரணிகளால்  உடலில்
ஏற்படுகிறது?

(a) வயிற்றுப்புண்  (b) இரத்தசோகை  (c) கழுத்துக்கழலை  (d) சீரோப்தால்மியா

நீ ர்வெறுப்பு______ ஆல்  ஏற்படுகிறது.

(a) சின்னம்மை  (b) டைபாய்டு  (c) ரேபிஸ்  (d) காலரா

கீழ்க்கண் டவற்றில்  எது தொற்றா நோய்?

(a) வாத நோய்  (b) சின்னம்மை  (c) மஞ்சள்  காமாலை  (d) காலரா

_________என்பது பல கோப்புகளை உள்ளடக்கிய பெட்டகம்  போன்றது ஆகும் .

(a) அட்டவணை  (b) கோப்பு  (c) கோப்புத் தொகுப்பு  (d) வரிசை

பின்வரும்  எந்த கட்டளையைப் பயன்படுத்தி புதியதாக ஒரு கோப்புத் தொகுப்பினை
உருவாக்கலாம்?

(a) Format→ New → Folder  (b) File → New → Folder  (c) View → New → Folder
(d) Edit→ New → Folder

விண் டோஸ்  இயக்க அமைப்பில்  பின்வரும்  எந்த பயன்பாடு படங்கள்  வரையப்
பயன்படுகிறது?

(a) Notepad  (b) Paint  (c) Photoshop  (d) MS Word

பின்வரும்  எந்த மென்பொருளைப் பயன்படுத்தி புகைப்படக்காரர் புகைப்படத்தினை
பதிப்பாய்வு செய்வார்?

(a) Photoshop  (b) Photo Art  (c) Corel Draw  (d) MS Word

ராஸ் டர் கோப்பிற்கு எடுத்துக்காட்டு

(a) .eps  (b) .pdf  (c) .jpg  (d) .svg

ஒழுங்கற்ற வடிவமுள்ளள்ள பொருட்களின்  பருமனை அளக்க ______ விதி பயன்படுகிறது.

நீரின்  இடப்பெயர்ச்சி

ஒரு கன மீட்டர் என்பது _______ கன சென்டிமீட்டர்.

10,00,000

பாதரசத்தின்  அடர்த்தி ______ 

13,600 கி.கி./மீ3

ஒரு வானியல்  அலகு என்பது ______

1.496 x 10  மீ11

ஓர் இலையின்  பரப்பை ______ பயன்படுத்தி கணக்கிடலாம் .

வரைப்படத்தாளை

இரு இடங்களுக்கு இடையே உள்ள மிகக் குறைந்த தூரம்  _____ எனப்படும் .

இடப்பெயர்ச்சி

திசைவேகம்  மாறுபடும்  வீதம்  ______ ஆகும் .

முடுக்கம்
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ஒரு பொருளின்  திசைவேகமானது காலத்தினைப் பொருத்து அதிகரித்தால்  அப்பொருள்  ______
முடுக்கத்தினைப் பெற்றிருக்கிறது என்கிறோம் .

நேர்

வேகம்-காலம்  வரைபடத்தின்  சாய்வு _______ மதிப்பினைத் தருகிறது.

சீரற்ற முடுக்கம்

______ சமநிலையில்  அதன்  ஈர்ப்புமையத்தின்  நிலை மாறுவதில்லை.

நடுநிலை

ஒரு கார்பன்  அணு மற்றும்  இரண் டு ஆக்சிஜன்  அணுக்களைக் கொண் ட சேர்மம்  _____

CO₂

_____ மின்சாரத்தைக் க கடத்தும்  ஒரே அலோகம் .

கிராஃபைட்

தனிமங்கள்  _____ வகையான அணுக்களால்  உருவாக்கப்பட்டுள்ளன.

ஒரே

சில தனிமங்களின் ______ லத்தீன்  அல்லது கிரேக்கப் பெயர்களிலிருந்து பெறப்படுகின்றன.

குறியீடுகள்

இதுவரை அறியப்பட்ட தனிமங்களின்  எண் ணிக்கை _____

118

தனிமங்கள்  தூய பொருட்களின்  _____ வடிவம் .

எளிமையான

தனிமங்களின்  பெயரை எழுதும்போது முதல்  எழுத்தை எப்போதுமே ______ எழுத்தால்
எழுதவேண் டும் .

பெரிய

மூன்றுக்கும்  மேற்பட்ட அணுக்களை க் கொண் ட மூலக்கூறுகளை ______  மூலக்கூறுகள்  என்று
அழைக்கலாம் .

பல அணு

____ வளிமண் டலத்தில்  அதிகளவு காணப்படும்  வாயு.

நைட்ரஜன்

ஒரு அணுவில்  காணப்படும்  மிகச்சிறிய துகள்  _____

  அடிப்படைத் துகள்கள்

அணுவின்  உட்கருவில்  ______ மற்றும்  _____ இருக்கும் .

புரோட்டான்கள் , நியூட்ரான்கள்

அணுவின்  உட்கருவை _____ சுற்றி வரும் .

எலக்ட்ரான்கள்

கார்பனின்  இணைதிறன்  4 மற்றும்  ஹைட்ரஜனின்  இணைதிறன்  1 ஆக உள்ளது எனில் ,
மீத்தேனின்  மூலக்கூறு வாய்ப்பாடு _____

  CH4

மெக்னீசியம்  அணுவின்  வெளிவட்டப் பாதையானது இரண் டு எலக்ட்ரான்களைக்
கொண் டிருக்கிறது எனில் , மெக்னீசியம்  அணுவின்  இணைதிறன்  ______

2

மலரின்  ஆண்  இனப்பெருக்க உறுப்பு  _________

மகரந்தத்தாள்

_________ என்பது சூலக வட்டத்தின்  பருத்த அடிப்பகுதியாகும்
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சூலகம்

கருவுறுதலுக்குப் பின்  சூல்   _________ ஆக மாறுகிறது.

விதை

சுவாச வேர்கள்   ________  தாவரத்தில்  காணப்படுகின்றன

அவிசினியா

வெங்காயம்  மற்றும்  பூண் டு ________  வகைக்கு  எடுத்துக்காட்டுகளாகும் .

குமிழம்

ஒரு குறிப்பிட்ட பகுதியில்  ஒன்றாக வாழும்  மக்களை  ________ என அழைக்கிறோம் .

சமூகம்

நான்  பச்சை நிறத்தில்  குப்பைகளோடு இருக்கக்கூடிய பெட்டி. நான் _________ 

  குப்பைத்தொட்டி

கண் கள்  உலகினைக் காணப் பயன்படும்  ________ கருதப்படுகின்றன

  சாளரங்களாக

முடியை மென்மையாக வைத்திருக்க மயிர்க்கால்கள்________ உற்பத்தி செய்கின்றன.

எண் ணெய்

காசநோய்  என்பது  ________ பாக்டீரியாவால்  ஏற்படுகிறது.

மைக்கோ பாக்டீரியம்  டியூபர்குலே

கூற்று: கல்லின்  கன அளவை அளவிடும்  முகவை மூலம்  அளக்கலாம் .
காரணம் : கல்  ஒரு ஒழுங்கற்ற வடிவமுடைய பொருள் .
அ. கூற்று மற்றும்  காரணம்  இரண் டும்  சரி, காரணம்  கூற்றிற்கான சரியான விளக்கம் .
ஆ. கூற்று மற்றும்  காரணம்  இரண் டும்  சரி ஆனால் , காரணம்  கூற்றிற்கான சரியான
விளக்கமல்ல.
இ. கூற்று சரி. ஆனால் , காரணம்  தவறு.
ஈ. கூற்று தவறு. ஆனால் , காரணம்  சரி.

Answer :   அ. கூற்று மற்றும்  காரணம்  இரண் டும்  சரி, காரணம்  கூற்றிற்கான சரியான
விளக்கம் .

கூற்று: மரக்கட்டை நீ ரில்  மிதக்கும் .
காரணம் : நீ ர் ஒரு ஒளி ஊடுருவும்  திரவம் .
அ. கூற்று மற்றும்  காரணம்  இரண் டும்  சரி, காரணம்  கூற்றிற்கான சரியான விளக்கம் .
ஆ. கூற்று மற்றும்  காரணம்  இரண் டும்  சரி ஆனால் , காரணம்  கூற்றிற்கான சரியான
விளக்கமல்ல.
இ. கூற்று சரி. ஆனால் , காரணம்  தவறு.
ஈ. கூற்று தவறு. ஆனால் , காரணம்  சரி.

Answer :   ஆ. கூற்று மற்றும்  காரணம்  இரண் டும்  சரி ஆனால் , காரணம்  கூற்றிற்கான
சரியான விளக்கமல்ல.

கூற்று : ஓர் இரும்புக் குண் டு நீ ரில்  மூழ்கும்
காரணம் : நீ ர் இரும்பைவிட அடர்த்தி அதிகமுடையது.
அ. கூற்று மற்றும்  காரணம்  இரண் டும்  சரி, காரணம்  கூற்றிற்கான சரியான விளக்கம் .
ஆ. கூற்று மற்றும்  காரணம்  இரண் டும்  சரி ஆனால் , காரணம்  கூற்றிற்கான சரியான
விளக்கமல்ல.
இ. கூற்று சரி. ஆனால் , காரணம்  தவறு.
ஈ. கூற்று தவறு. ஆனால் , காரணம்  சரி.

Answer :   இ. கூற்று சரி. ஆனால் , காரணம்  தவறு.

கூற்று: ஆக்சிஜன்  ஒரு சேர்மம் .
காரணம் : ஆக்சிஜனை எளிய வகையில்  உடைக்க முடியாது.
அ. கூற்று மற்றும்  காரணம்  இரண் டும்  சரி. காரணம்  கூற்றிற்கான சரியான விளக்கம் .
ஆ. கூற்று மற்றும்  காரணம்  இரண் டும்  சரி. ஆனால் , காரணம்  கூற்றிற்கான சரியான
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விளக்கமல்ல.
இ. கூற்று சரி. ஆனால் , காரணம்  தவறு.
ஈ. கூற்று தவறு. ஆனால் , காரணம்  சரி.

Answer : ஈ. கூற்று தவறு. ஆனால் , காரணம்  சரி.

கூற்று: ஹைட்ரஜன்  ஒரு தனிமம் .
காரணம் : ஹைட்ரஜனை எளிய வகையில்  உடைக்க முடியாது.
அ. கூற்று மற்றும்  காரணம்  இரண் டும்  சரி. காரணம்  கூற்றிற்கான சரியான விளக்கம் .
ஆ. கூற்று மற்றும்  காரணம்  இரண் டும்  சரி. ஆனால் , காரணம்  கூற்றிற்கான சரியான
விளக்கமல்ல.
இ. கூற்று சரி. ஆனால் , காரணம்  தவறு.
ஈ. கூற்று தவறு. ஆனால் , காரணம்  சரி.

Answer : அ. கூற்று மற்றும்  காரணம்  இரண் டும்  சரி. காரணம்  கூற்றிற்கான சரியான
விளக்கம் .

கூற்று: காற்று ஒரு சேர்மம்  ஆகும் .
காரணம் : காற்றில்  கரியமில வாயு உள்ளது.
அ. கூற்று மற்றும்  காரணம்  இரண் டும்  சரி. காரணம்  கூற்றிற்கான சரியான விளக்கம் .
ஆ. கூற்று மற்றும்  காரணம்  இரண் டும்  சரி. ஆனால் , காரணம்  கூற்றிற்கான சரியான
விளக்கமல்ல.
இ. கூற்று சரி. ஆனால் , காரணம்  தவறு.
ஈ. கூற்று தவறு. ஆனால் , காரணம்  சரி.

Answer : ஈ. கூற்று தவறு. ஆனால் , காரணம்  சரி.

கூற்று: காற்று தனிமங்களின்  கலவை.
காரணம் : நைட்ரஜன் , ஆக்சிஜன்  மற்றும்  நியான்  போன்றவை காற்றில்  உள்ளன.
அ. கூற்று மற்றும்  காரணம்  இரண் டும்  சரி. காரணம்  கூற்றிற்கான சரியான விளக்கம் .
ஆ. கூற்று மற்றும்  காரணம்  இரண் டும்  சரி. ஆனால் , காரணம்  கூற்றிற்கான சரியான
விளக்கமல்ல.
இ. கூற்று சரி. ஆனால் , காரணம்  தவறு.
ஈ. கூற்று தவறு. ஆனால் , காரணம்  சரி.

Answer : ஆ. கூற்று மற்றும்  காரணம்  இரண் டும்  சரி. ஆனால் , காரணம்  கூற்றிற்கான
சரியான விளக்கமல்ல.

கூற்று: பாதரசம்  அறை வெப்பநிலையில்  ஒரு திண் மம் .
காரணம் : பாதரசம்  ஒரு அலோகம் .
அ. கூற்று மற்றும்  காரணம்  இரண் டும்  சரி. காரணம்  கூற்றிற்கான சரியான விளக்கம் .
ஆ. கூற்று மற்றும்  காரணம்  இரண் டும்  சரி. ஆனால் , காரணம்  கூற்றிற்கான சரியான
விளக்கமல்ல.
இ. கூற்று சரி. ஆனால் , காரணம்  தவறு.
ஈ. கூற்று தவறு. ஆனால் , காரணம்  சரி.
உ.  கூற்று மற்றும்  காரணம்  இரண் டும் தவறு.

Answer : உ.  கூற்று மற்றும்  காரணம்  இரண் டும் தவறு.

கூற்று : ஓர் அணு மின்சுமையற்றது நடுநிலையானது
காரணம் : அணுக்கள்  சம எண் ணிக்கையிலான எலக்ட்ரான்களையும்  புரோட்டான்களையும்
கொண் டவை.
அ.கூற்று மற்றும்  காரணம்  இரண் டும்  சரி. காரணம்  கூற்றிற்கான சரியான விளக்கம் .
ஆ. கூற்று மற்றும்  காரணம்  இரண் டும்  சரி. ஆனால் , காரணம்  கூற்றிற்கான சரியான
விளக்கமல்ல.
இ. கூற்று சரி. ஆனால் , காரணம்  தவறு.
ஈ. கூற்று தவறு. ஆனால் , காரணம்  சரி.

Answer : அ.கூற்று மற்றும்  காரணம்  இரண் டும்  சரி. காரணம்  கூற்றிற்கான சரியான
விளக்கம் .

கூற்று: ஓர் அணுவின்  நிறை என்பது அதன்  உட்கருவின்  நிறையாகும் .
காரணம் : உட்கரு மையத்தில்  அமைந்துள்ளது.
அ.கூற்று மற்றும்  காரணம்  இரண் டும்  சரி. காரணம்  கூற்றிற்கான சரியான விளக்கம் .
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ஆ. கூற்று மற்றும்  காரணம்  இரண் டும்  சரி. ஆனால் , காரணம்  கூற்றிற்கான சரியான
விளக்கமல்ல.
இ. கூற்று சரி. ஆனால் , காரணம்  தவறு.
ஈ. கூற்று தவறு. ஆனால் , காரணம்  சரி.
 

Answer :   ஆ. கூற்று மற்றும்  காரணம்  இரண் டும்  சரி. ஆனால் , காரணம்  கூற்றிற்கான
சரியான விளக்கமல்ல.

கூற்று : புரோட்டான்கள்மற்றும்  நியூட்ரான்களின்  எண் ணிக்கை அணு எண் ணாகும் .
காரணம் : புரோட்டான்கள்  மற்றும்  நியூட்ரான்களின்  மொத்த எண் ணிக்கை நிறை எண் ணாகும் .
அ.கூற்று மற்றும்  காரணம்  இரண் டும்  சரி. காரணம்  கூற்றிற்கான சரியான விளக்கம் .
ஆ. கூற்று மற்றும்  காரணம்  இரண் டும்  சரி. ஆனால் , காரணம்  கூற்றிற்கான சரியான
விளக்கமல்ல.
இ. கூற்று சரி. ஆனால் , காரணம்  தவறு.
ஈ. கூற்று தவறு. ஆனால் , காரணம்  சரி.

Answer : ஆ. கூற்று மற்றும்  காரணம்  இரண் டும்  சரி. ஆனால் , காரணம்  கூற்றிற்கான
சரியான விளக்கமல்ல.  

கூற்று: பூவில்  நடைபெறும்  மகரந்தச் சேர்க்கை மற்றும்  கருவுறுதல் , கனிகளையும் ,
விதைகளையும்  உருவாக்குகின்றன.
காரணம்  : கருவுறுதலுக்குப் பின்  சூற்பை கனியாக மாறுகிறது. சூலானது, விதையாக
மாறுகிறது.
அ. கூற்று மற்றும்  காரணம்  இரண் டும்  சரி, காரணம்  கூற்றிற்கான சரியான விளக்கம் .
ஆ. கூற்று மற்றும்  காரணம்  இரண் டும்  சரி. ஆனால் , காரணம்  கூற்றிற்கான சரியான
விளக்கமல்ல .
இ. கூற்று சரி. ஆனால் , காரணம்  தவறு.
ஈ. கூற்று தவறு. ஆனால் , காரணம்  சரி.

Answer : அ. கூற்று மற்றும்  காரணம்  இரண் டும்  சரி, காரணம்  கூற்றிற்கான சரியான
விளக்கம் .

கூற்று : கூம்பு வடிவ வேருக்கு எடுத்துக்காட்டு கேரட் ஆகும்
காரணம்  : இது வேற்றிட  வேரின்  மாறுபாடாகும்
அ. கூற்று மற்றும்  காரணம்  இரண் டும்  சரி, காரணம்  கூற்றிற்கான சரியான விளக்கம் .
ஆ. கூற்று மற்றும்  காரணம்  இரண் டும்  சரி. ஆனால் , காரணம்  கூற்றிற்கான சரியான
விளக்கமல்ல .
இ. கூற்று சரி. ஆனால் , காரணம்  தவறு.
ஈ. கூற்று தவறு. ஆனால் , காரணம்  சரி.

Answer : இ. கூற்று சரி. ஆனால் , காரணம்  தவறு.

கூற்று: வாய்ச்சுகாதாராம்  நல்ல து.
காரணம் : நல்ல பற்கள்  ஆரோக்கியமான திசுக்களைக் கொண் ட ஈறுகளால்  சூழப்பட்டுள்ளன.
அ. கூற்று மற்றும்  காரணம்  இரண் டும்  சரி, காரணம்  கூற்றிற்கா ன சரியான விளக்கம் .
ஆ. கூற்று மற்றும்  காரணம்  இரண் டும்  சரி. ஆனால் , காரணம்  கூற்றிற்கா ன சரியான
விளக்கமல்ல .
இ. கூற்று சரி. ஆனால் , காரணம்  தவறு.
ஈ. கூற்று தவறு. ஆனால் , காரணம்  சரி.

Answer : அ. கூற்று மற்றும்  காரணம்  இரண் டும்  சரி, காரணம்  கூற்றிற்கா ன சரியான
விளக்கம் .

கூற்று : சின்னம்மை ஒரு வைரஸ்  தொற்று நோயாகும் .
காரணம்  : உடல்  முழுவதும்  தடிப்புகள் , காய்ச்சல் , மற்றும்  அம்மை கொப்புளங்கள்  போன்ற
அறிகுறிகளைக் கிருமிகள்  தோற்றுவிக்கின்றன.
அ. கூற்று மற்றும்  காரணம்  இரண் டும்  சரி, காரணம்  கூற்றிற்கா ன சரியான விளக்கம் .
ஆ. கூற்று மற்றும்  காரணம்  இரண் டும்  சரி. ஆனால் , காரணம்  கூற்றிற்கா ன சரியான
விளக்கமல்ல .
இ. கூற்று சரி. ஆனால் , காரணம்  தவறு.
ஈ. கூற்று தவறு. ஆனால் , காரணம்  சரி.
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Answer : அ. கூற்று மற்றும்  காரணம்  இரண் டும்  சரி, காரணம்  கூற்றிற்கா ன சரியான
விளக்கம் .

கூற்று : வரைபடத்தாள்  முறையை பயன்படுத்தி ஒரு இலையின்  பரப்பை காண முடியும் .
காரணம்  : இலைக்கென்று ஒரு குறிப்பிட்ட வடிவம்  இல்லை.
அ. கூற்று மற்றும்  காரணம்  இரண் டும்  சரி, காரணம்  கூற்றிற்கான சரியான விளக்கம் .
ஆ. கூற்று மற்றும்  காரணம்  இரண் டும்  சரி ஆனால் , காரணம்  கூற்றிற்கான சரியான
விளக்கமல்ல.
இ. கூற்று சரி. ஆனால் , காரணம்  தவறு.
ஈ. கூற்று தவறு. ஆனால் , காரணம்  சரி.

Answer : அ. கூற்று மற்றும்  காரணம்  இரண் டும்  சரி, காரணம்  கூற்றிற்கான சரியான
விளக்கம் .

கூற்று : திரவங்களின்  கன அளவை ஒரு அளவிடும்  முகவை மூலம்  அளக்கலாம் .
காரணம்  : திரவங்களுக்கு ஒரு குறிப்பிட்ட வடிவம்  உண் டு.
அ. கூற்று மற்றும்  காரணம்  இரண் டும்  சரி, காரணம்  கூற்றிற்கான சரியான விளக்கம் .
ஆ. கூற்று மற்றும்  காரணம்  இரண் டும்  சரி ஆனால் , காரணம்  கூற்றிற்கான சரியான
விளக்கமல்ல.
இ. கூற்று சரி. ஆனால் , காரணம்  தவறு.
ஈ. கூற்று தவறு. ஆனால் , காரணம்  சரி.

Answer : இ. கூற்று சரி. ஆனால் , காரணம்  தவறு.

கூற்று : நீ ரில்  ஒரு துளி எண் ணெயை இடும்பொழுது அது மிதந்து நீ ரின்  மீது ஒரு படலத்தை
உருவாக்கும் .
காரணம்  : எண் ணெயை விட நீ ரின்  அடர்த்தி அதிகம் .
அ. கூற்று மற்றும்  காரணம்  இரண் டும்  சரி, காரணம்  கூற்றிற்கான சரியான விளக்கம் .
ஆ. கூற்று மற்றும்  காரணம்  இரண் டும்  சரி ஆனால் , காரணம்  கூற்றிற்கான சரியான
விளக்கமல்ல.
இ. கூற்று சரி. ஆனால் , காரணம்  தவறு.
ஈ. கூற்று தவறு. ஆனால் , காரணம்  சரி.

Answer : அ. கூற்று மற்றும்  காரணம்  இரண் டும்  சரி, காரணம்  கூற்றிற்கான சரியான
விளக்கம் .

கூற்று : ஓர் இடத்திலிருந்து மற்றோர் இடத்தை அடைவதற்கு, ஒரு பொருள்  கடந்து வந்த
பாதையின்  மொத்த நீளம்  தொலைவு எனப்படும் .
காரணம்  : ஒரு பொருளின்  இயக்கத்தின் போது, அதன்  துவக்க நிலைக்கும்  இறுதி நிலைக்கும்
இடையே உள்ள மிகக் குறைந்த நேர்க்கோட்டுத் தொலைவு இடப்பெயர்ச்சி எனப்படும் .
அ) கூற்றும்  காரணமும்  சரி மற்றும்  காரணம்  கூற்றிற்கான சரியான விளக்கம் .
ஆ) கூற்றும்  காரணமும்  சரி ஆனால்  காரணம்  கூற்றிற்கான சரியான விளக்கமில்லை.
இ) சுற்று சரி ஆனால்  காரணம்  தவறு.
ஈ) கூற்று தவறு ஆனால்  காரணம்  சரி.

Answer : ஆ) கூற்றும்  காரணமும்  சரி ஆனால்  காரணம்  கூற்றிற்கான சரியான
விளக்கமில்லை.

கூற்று : திசைவேகம்  மாறுபடும்  வீதம்  முடுக்கம்  எனப்படும் .
காரணம்  : ஒரு பொருளின்  வேகத்திலோ அல்லது திசையிலோ மாற்றம்  ஏற்பட்டால்  அப்பொருள்
முடுக்கடைகிறது.
அ) கூற்றும்  காரணமும்  சரி மற்றும்  காரணம்  கூற்றிற்கான சரியான விளக்கம் .
ஆ) கூற்றும்  காரணமும்  சரி ஆனால்  காரணம்  கூற்றிற்கான சரியான விளக்கமில்லை.
இ) சுற்று சரி ஆனால்  காரணம்  தவறு.
ஈ) கூற்று தவறு ஆனால்  காரணம்  சரி.

Answer : அ) கூற்றும்  காரணமும்  சரி மற்றும்  காரணம்  கூற்றிற்கான சரியான விளக்கம் .

கூற்று : தாம்ஸன்  கொள்கைப்படி, அணுவானது எவ்வித மின்சுமையும்
கொண் டிருக்கவில்லை.
காரணம்  : அணுவில்  நேர் மற்றும்  எதிர் மின்னூட்டங்கள்  சம எண் ணிக்கையில்
காணப்படுகின்றன.
அ.கூற்று மற்றும்  காரணம்  இரண் டும்  சரி. காரணம்  கூற்றிற்கான சரியான விளக்கம் .
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ஆ. கூற்று மற்றும்  காரணம்  இரண் டும்  சரி. ஆனால் , காரணம்  கூற்றிற்கான சரியான
விளக்கமல்ல.
இ. கூற்று சரி. ஆனால் , காரணம்  தவறு.
ஈ. கூற்று தவறு. ஆனால் , காரணம்  சரி.

Answer : அ.கூற்று மற்றும்  காரணம்  இரண் டும்  சரி. காரணம்  கூற்றிற்கான சரியான
விளக்கம் .

கூற்று : ஹீலியத்தின்  அணு எண்  4 ஆகும் .
காரணம்  : ஹீலியம்  அணுவின்  உட்கருவில்  இரண் டு எலக்ட்ரான்களும்  உள்ளன.
அ.கூற்று மற்றும்  காரணம்  இரண் டும்  சரி. காரணம்  கூற்றிற்கான சரியான விளக்கம் .
ஆ. கூற்று மற்றும்  காரணம்  இரண் டும்  சரி. ஆனால் , காரணம்  கூற்றிற்கான சரியான
விளக்கமல்ல.
இ. கூற்று சரி. ஆனால் , காரணம்  தவறு.
ஈ. கூற்று தவறு. ஆனால் , காரணம்  சரி.

Answer : ஈ. கூற்று தவறு. ஆனால் , காரணம்  சரி.

கூற்று : அம்மோனியாவின்  மூலக்கூறு வாய்ப்பாடு NH
காரணம்  : இரண் டு புரோட்டான்களும் , அணுக்கருவிற்கு வெளியே அம்மோனியா மூலக்கூறில்  N
மற்றும்  H ன்  இணைதிறன்கள்  முறையே 1 மற்றும்  3 ஆகும் .
அ.கூற்று மற்றும்  காரணம்  இரண் டும்  சரி. காரணம்  கூற்றிற்கான சரியான விளக்கம் .
ஆ. கூற்று மற்றும்  காரணம்  இரண் டும்  சரி. ஆனால் , காரணம்  கூற்றிற்கான சரியான
விளக்கமல்ல.
இ. கூற்று சரி. ஆனால் , காரணம்  தவறு.
ஈ. கூற்று தவறு. ஆனால் , காரணம்  சரி.
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